DETAILED Step By Step for Kwik Model® with EnergyGauge® Loads

1. Start Kwik Model
a. Read and accept EULA

2. Project Info Tab

a. Enter the name of your drawing in the top “Project Name” input of the panel on
the left hand side. This is required.

b. Enter other information in the following inputs, as needed. This is just
informational data. The design city will be specified in EnergyGauge.

c. In the bottom Left Panel:

* “Cond Floor Plans Area” is what you expect the floor area to be, based
on the architectural plans or other information.

* “From Drawing” shows the conditioned floor area of the Kwik Model 3D
house.

o When you are done building the house. These two numbers

should be close to each other.
* “Volume” shows the volume of the of the Kwik Model 3D house
* “Total Surface Area” shows the total exterior surface area. This is used
for some infiltration rate calculations.
3. Libraries Tab

a. Specify your default surface types in each table. Each row represents a type, or
collection of values to be assigned to an envelope, such as a wall, ceiling, floor
or window.

* Each new envelope created will be listed in the table under the Data
Tab, and will start off with the current default type assigned to it, but
you can reassign it to a different type later.

* You can go in and change individual surfaces later. If you modify the
information in a row, all surfaces with that type will reflect those
changes.

o This means if you want to change everything that is assigned to
one type, to a similar one, you can just edit the values of the
current type rather than reassigning it.

o if you want to do this while keeping the old type in the
libraries table, you can duplicate the old type first.

b. The default type is shown highlighted in green

* To set a type as the default, highlight it, then click “Set Type as Default”.

c. Make sure the name is accurately representative of the surface.

* Avoid using performance values in the name that might change (U
factor, SHGC, R-value, etc.). It can lead to confusion if the name is not
reflective of the accurate performance values. (e.g, calling a wall “R-13
Wall” but the performance value is set to R-19.)

d. To create a new type, click on one of the existing ones, and click the “Duplicate”
button. This creates a duplicate surface type that can then be modified to fit
your requirements.

e. Similarly, to delete a type, select its row, and click the “Delete” button ¢ If you

delete a type, surfaces of that type will be changed to the default.



f. You cannot delete the row designated as the default. You must assign a
different type to be the default first.

g. Note that on a multi story house, you will probably want to change the default
floor type after you complete the first floor.

h. Library types can be exported and saved using the “Export” button and
imported into other projects using the “Import” button. Save them in a
folder called “Libraries” so they are easy to find later.

i. On the left side of the Screen is the Favorites list, which can be expanded by
clicking on the “Favorites” button.

* This is a list of types that can be saved from and loaded to any project. °
You can choose from the types based on the type of table open (such as
floor types when you have the floor type library table open), save types
to the list, load types from the list into your current project’s libraries, or
delete the current type from the favorites drop down by using the
buttons below the dropdown.
4. Floor Plan Tab
a. Elevations
* Start with the first floor. Avoid changing these values after you have
placed rooms. It can cause rooms not to align properly. Room ceiling
heights can be changed individually in the rooms tab
* Set default floor thicknesses (default = 0.5’)
o Slab on grade, use 0.5’ (6”)
o Floor over crawlspace, use height of crawl space plus height of
floor framing (typically 1') or just use height of floor framing.
o 2"and 3"level floors, use height of floor framing
* Set default room height, aka plate height (default = 8’)
* Set default roof truss heel height (default = 0’) Note: raised heel trusses
are not common.
* Notes:
o Rooms can not be brought below their floor level, so plan
accordingly.
o To see which floor is being edited, when you have multiple floors
created, look for the “Edit Plan” toggle on the floor visibility
panels on the right side of the screen. You can also toggle off the
floors to hide them.
o We recommend using 2D mode and Top view for the next steps.
o The 2D Toggle, and top view buttons can be found at the

top right corner of the screen
b. Import Floor Plan

* Select an image file which will be placed on the floor you are currently
editing
* Most file formats are supported
* We would recommend avoiding PDFs as they expand when imported
o You can use the windows snipping tool, to create a cropped
screenshot of your PDF



c. Scale Floor Plan.

* Scale left to right by aligning the ends of the red arrow with some
known dimension on the floor plan. Enter the known dimension in
the inputbox on the left, then click “Scale” below. (Doing this with
longer

dimensions will make the scaling more accurate, so you may want to
scale it to a larger value first, then readjust the arrows, and then
scale again)
* Repeat the previous step with the blue arrowed line to scale the
floorplan back to front.
* Double-check any dimensions with yellow ruler arrows, which will
show the lengths between them on the left side of the screen
when
selected. Adjust as necessary.
d. Drag and Rotate
* Click on the floor plan and line up a main reference corner of it with the
grid.
* Use the tab key or the “Tab: Rotate Image” button to rotate the floor
plan 90 degrees.
e. Crop Floor Plan
* Use the screen that appears on the bottom left to crop the floor plan, if
necessary. It contains 4 toggles to edit the image
* Slide: The top toggle slides the image left to right; The right toggle slides
the image down up
* Stretch: The bottom toggle stretches the image left to right; The left
toggle stretches the image down up
f. Rotate Front - Rotate the dial underneath the floor plan to specify where the
front of the house is. This, respectively, adjusts the compass angle along with it.
You can also adjust the front by inputting a “Forward Angle Relative To Grid”
in its respective input box. Check whether or not you want to “Rotate Compass
Too” then hit enter.
g. If you wish to adjust the compass angle to be accurate to the home’s location in
real life, click on the compass and adjust to your desired angle.
5. Rooms Tab
a. Start on lowest story (turn off other stories using view controls in bottom right
corner of screen)
b. Place boxes to cover all rooms, vaulted ceilings, etc by holding the alt key while
clicking anywhere on the floor plan.
c. Drag and resize the box to fill in the shape of each room using one or multiple
boxes. We have a variety of box shapes to choose from in the left-hand panel. d.
Group boxes into rooms (each room will need at least one register. Spaces
without a register such as closets and hallways will need to be grouped with a
room).
* To select multiple rooms, hold the shift or ctrl key while selecting them
o they should all be highlighted orange to show they are still
selected
* To group selected rooms, press ctrl+G or click the group button on the



left side of the screen.

e. Indicate any unconditioned rooms (e.g., garage) by selecting the rooms you
wish to designate, then using the dropdown menu on the left to select from
conditioned/ unconditioned/ unconditioned garage etc.

f. For below grade rooms, create “Earth” boxes adjacent to them using the same
dropdown menu as the previous step.

g. For Rooms in a shared space such as an apartment, you can use “Other’s
conditioned” boxes in a similar fashion to “Earth boxes” Neither of these will
be

counted in the table, they are just used to determine where other room
boxes are touching a specific kind of space.

h. “Check Alignment” on the left-hand panel will check for boxes that are very
close, but not touching. Adjust as necessary.

i. You can copy selected rooms with ctrl+c and paste with ctrl+alt+click j. If

rooms are being placed on the incorrect floor, or you can’t seem to select a

room, check the visibility panels on the right. Make sure the “Edit rooms”

toggle is on for the correct floor.

6. Windows/Doors Tab

a. To place a window or skylight, select the “Windows” option on the left, then
hold the alt key and click on a room to place the window. You can adjust
the default size of a new window under “Default Scale:”.

* After placing a window, you can change the width and height using the
panel at the bottom left or drag them around with your mouse. You
can also change values like window name, type, and distance from
ceiling in this panel.

b. To place an exterior door, select the “Doors” option on the left then hold the alt
key and click on a room to place the door.

* After placing you can adjust the size, distance from top, and horizontal
offset in the bottom-left panel. You can also click and drag the door to
move it.

c. For Doors, you can mark one as the main/front door.

<<Repeat steps C - E for additional stories (floors)>>

7. HVAC Draw Tab
a. Click on the ‘Air Handlers’ button at the left to select the air handler tool.
b. Place at least one air handler with alt + left click .
- There is an ‘orientation to place’ drop down menu on the left to
determine what kind of system it will place with your click.
c. You can name an air handler, and set its dimensions for each section by
clicking on a section and using the inputs in the panel at the bottom left.
- The sections are:
- White [X]: supply plenum
- Blue: Coil
- Red: Fan box
- Grey [\]: return plenum
- You can also change the selected air handler’s rotation with the
dropdown in the same panel



d. If you place more than one air handler, you will need to assign rooms to the
appropriate “System/Block” in the “Rooms” table (Data tab).
8. Roofs Tab
a. Place roofs as needed. This is Optional. Currently roofs are only visual and do
not affect any calculations.
b. The only data points needed for roofs are slope and a roof type from
the libraries tab for the roof designated as the “main” roof
c. If you don’t wish to draw the roof, select the “Enter Roof Slope Manually”
toggle, and enter a valid slope height in inches.
* A roof listing will appear on the Data tab where you can change the type
of roof from the libraries
d. If you wish to add a flat roof, select the “Place as Flat Roof”
option. e. To add the roof, hold alt then click to place it
* Once placed, you can drag the corner handles to adjust the roof size.
Drag the top two handles to adjust the angle of the roof. Select the
“Vertical Move” option on the left panel to move the roof vertically,
or one of the chosen handles on the roof.
o the bottom vertices will stay at the same height on a non-flat
roof
f. On the bottom left panel, select whether or not the roof is the “Main Roof”.
Click the “Rotate 90 degree” option to rotate the roof (hitting the tab key
does

the same thing). Below you will see the roof dimensions. These can be
adjusted if necessary
NOTE: Some steps before proceeding to the Data tables:
* Go to the Rooms Tab, Name all rooms, which can consist of one or more
grouped boxes.
* Double check that all boxes are associated with a named room.
o You can set the “Show Names” dropdown to “Room Names” and
then select a room to show which rooms are grouped together.
o (Unconditioned rooms will not show in the table unless the
“unconditioned” box is checked at the bottom-left panel.)
* Go to the HVAC Draw tab, and select the “air handler” button, and then
alt+click to place an air handler for each System/Block in your
project.

9. Data Tab
a. Rooms Table

* If more that one air handler was placed, assign rooms to air handlers in
“System/Block” column (air handler names can be changed in the “Air
Handler” table)

* Assign a “Room Type” to each room. New types can be created in
“Libraries” tab. Only kitchens and bedrooms affect loads. All other
rooms can be “Other”.

* Enter # of occupants in each room (Used for internal cooling loads. Total
number of people typically equals the number of bedrooms plus 1. Put



people where they are likely to be during the late afternoon. Family
room, Kitchen, etc.)
b. Walls Table
» Wall names can be changed, if desired.
* Assign Wall Types, as needed. New types can be created in the
“Libraries” tab.
* Double check walls against plans.
c. Ceilings Table
* Ceiling names can be changed, if desired.
* Assign Ceiling Types, as needed. New types can be created in the
“Libraries” tab.
* Double check Ceilings against plans.
d. Floors Table
* Floor names can be changed, if desired.
* Assign Floor Types, as needed. New types can be created in the
“Libraries” tab.
* Double check Floors against plans.
e. Windows Table
* Window names can be changed, if desired. Default names are F = front,
L = left, B = Back, R = right, BR = back right, etc.
* Assign Window Types, as needed. New types can be created in the
“Libraries” tab.
* Double check windows against plans. Windows have a very big impact
on load calculations.
f. Doors Table

* Door names can be changed, if desired.
* Assign Door Types, as needed. New types can be created in the
“Libraries” tab.
* Double check Doors against plans.
g. Roof Table.
* Select a type for your main roof.
* Make sure your main roof has the correct slope as well.

10. Energy Gauge Loads - This button opens “EnergyGauge Loads” NOTE: Occasionally,
EnergyGauge will not completely close and may cause 1/0 errors. This can usually
be resolved by going into “Task Manager” (CTRL-ALT-DEL) and closing
EnergyGauge (End Task) and starting it again from Kwik Model.

a. Confirm that you want to save your work to this point.
b. Save it under the same name or a new name. A new name will create a new
project folder under the current project folder. It is recommended that if you

change the name, go up one folder level first (parent folder of current folder). c.
Edit “Climate Location”

* Select State
* Select City that is closest to location of project

* Confirm design conditions with the local jurisdiction having authority. *
Select desired “Sizing Design”

* Click “Return to MJ System Loads and Inputs”



d. Edit “Cooling” Note: “Systems/blocks” created in Kwik Model are called
“Blocks” in EnergyGauge. A block is a group of rooms or spaces that is
served by a single system; therefore, a system name and a block name are
essentially synonymous. EnergyGauge can handle up to five blocks. Houses
with more than 5 systems may need multiple files for different parts of the
house, each with 5 or less systems.

* Add a cooling system by clicking the red “+”.

* Select “Type”

* Select “Subtype”, if needed

* Select the block served by this cooling system (top right corner of
screen)

* Check box if cooling system is ductless.

* Click “Return to System and Load Inputs”

e. Edit “Heating”

* Add a heating system by clicking the red “+”.
* Select “Type”
* Select “Subtype”, if needed
* Select the block served by this heating system (top right corner of
screen)
* Check box if heating system is ductless.
* Click “Return to System and Load Inputs”
f. Edit “Duct”
* Add a duct system by clicking the red “+”.
* Specify supply and return duct R-values
* Specify supply and return duct locations
* Specify air handler location
* Specify duct condition

* Specify a leakage type.
* Assign duct system to a heating system and a cooling system
Indicate blower heat added to air stream (usually not needed) *
Click “Return to System and Load Inputs”
g. Edit “Mechanical Ventilation”
* Add a mechanical ventilation system by clicking the red “+”. ¢
Specify type and complete all information as needed.
* Specify which block is served by this mechanical system.
* Click “Return to System and Load Inputs”
h. Confirm set points (68 and 75 are standard)
i. Confirm Infiltration method (Default is recommended)
j- Confirm window peak load option (summer is recommended)
k. Confirm Internal Gains (leave checked)
1. Click “Calculate ACCA M]8 Loads”
* A summary page of the total house loads opens up
* Click on “Reports” tab at top. Review all reports.
m. Click “Continue to Manual S / Manual D==>" - this opens a Manual S
summary showing all systems/blocks
n. Click “Edit Block 1” under step 2



* Review Outdoor Conditions
* Review Room Conditions
* Review Manual | Design Loads
* Review heating and cooling targets
* Check box accepting responsibility to determine correct performance
values for equipment to be selected.
* Click “+ Step 2. AHRI Heating and Cooling Equipment”
o Select equipment according to Manual S
o Enter AHRI number (use 0000000 if generic)
o Enter other equipment information, if known
* Click “+ Step 3. AHRI Heating and Cooling Capacities and Efficiencies at
AHRI Test Conditions”
o Enter information, if known
* Click “+ Step 4. HVAC Fan Specifications”
o Indicate fan type
o Indicate fan speed for heating and cooling
o Enter HVAC fan airflow for heating and cooling
o Enter external static pressure for heating and cooling
* Click “+ Step 5. Estimate Airflow Temperatures entering equipment”
o Enter values
o or click “Show suggestions” and then click the button to
apply them
* Click “+ Step 6. OEM Specs at Design Conditions”
o Enter values, if known.
* Click “+ Step 7. Print Manual S Report”
o Review and revise if needed.
o Exit by clicking “X Quit”
* Click “Close/Return”

o Confirm that data entered will be used for equipment previously
entered.
* Repeat this section for other systems, if any.
* Click “<= Close Page/Return to Manual S Overview”

0. Click “* Save Work and Return to Kwik Model”

p. Click “Save and Return to Kwik Model”

q. Click “OK”

11. You will return to the Data Tab

a. Go to Rooms Table. Confirm that room loads and room airflows look
reasonable.

12. Duct Draw Mode (HVAC Draw Tab)

a. Place at least one register in every room (alt + left click). If more than one in a
room, airflow will be split evenly. Change register size, if desired. (has no
effect on calculations). Use the tab key to rotate the register.

* On the left side of the screen, you can choose whether the register will
be placed on ceiling/walls/floors, it will default to place on ceilings, and
will only be placed on sides of a room box that you click on that are

facing you.



* On the bottom left panel, with a register selected, you can choose if the
register is straight, 90 degrees, or an end register.

b. Place at least one return grille. If there is more than one return in the system,
supply registers will need to be assigned to a return grille in the duct table in
the data tab.

c. You can change the register size in the bottom left pane], if desired. (this has no
effect on calculations)

d. Draw ducts.
* Ducts require a start (orange) and end point (green) to be selected then

press enter to connect them with a duct based on which tool is

selected on the left (“flex duct” or “rigid duct”)
o The most simple pair of start and end points is a start collar to a

register.

o Fittings will generally contain a start point and in most cases at
least one endpoint, and are use to connect multiple ducts
together.

o If a startor end point is deleted, so will the duct connected to it.
* If you have “just need start collar” toggled on at the bottom left and then
press enter with only a start point selected, it will create a duct from
just that start point, and will add a fitting based on the dropdown on
the left to act as end point.

o If you have a duct selected and press enter, The duct will be split

into 2 which will be connected by the selected fitting type in the

dropdown on the left
* Use the fitting tool to place and move around the floating fittings
connecting the ducts as needed with the fitting tool selected on the
left panel. If you press alt+click, it will place the fitting type selected in
the position you place.
o If you select a fitting you can rotate it with the blue/yellow

handles or use the arrow keys or tab/shift+tab to rotate it.

o Pressing the R key will straighten the fitting’s rotation to the
nearest 90 degree angles.
* For flex ducts, with the flex duct tool selected, you can drag the center
or start/ end handles with the duct selected to shape it.
* Press the R key to straighten any ducts, Or hold Ctrl then press R to also

reset its in and out (green) handles

* (come back to this step at the end)
o Atthe bottom of the screen, there is a ‘change labels’ button to

show what information is on each duct. Duct labels will be
disabled until you go into the data table with your ducts already
created.

o If a branch/trunk has elbows and you want to move the label to
the other side of the label, click on the duct you want the label to
show up on and click the ‘show’ button on the left of the screen.

o You can drag the label like you would drag the center handle,
slide the ‘distance label along duct’ slider to move where on the



duct the label is pointing.
o If you hold shift and press R, it will reset the label position.
13. Friction Rate Mode
a. Use the TEL table to calculate total equivalent lengths.

* There are separate tables for supply and return runs.

Runs are Columns, while fittings are Rows. Select a cell to highlight the
run, and change the effective length of the fitting for that run.

* Kwik Model will automatically fill this table in based on how the ducts
are drawn, but you need to confirm that the values used are correct.
You can edit these values.

* You can also enter additional miscellaneous equivalent lengths in the
rows called “Extra Effective Length”. To add one of these rows, select
one of the add buttons at the bottom of the table.

b. Use the Friction rate table to calculate friction rate.

* The ESP and CFM you entered in the “+ Step 4. HVAC Fan Specifications”
part of Manual S shows up here.

* Step 2: enter all of the static pressure drops

* The friction rate will be automatically calculated.

* You can check the box to use the worst case TEL for all runs (not
recommended)

* You can look at the friction rate calculation for each run by selecting it
in the drop down menu.

14. Data Tab
a. Go to Duct table

* If more than one return was drawn, assign supply branches to returns.

* Assign duct types. New types can be created in “Library” mode.

* If there is more than one system, other systems can be viewed by

selecting the system in the drop down menu at the bottom of the table. *

Click “Auto Size Ducts”. Duct sizes will change in the table. Ducts will be

drawn to scale in drawing.

* If you get an error about the friction rate being too high or too low, you

will have to adjust the static pressure drops or the equivalent lengths.

Review everything! Recalculate loads and resize ducts if you make any changes.



Step By Step for Kwik Model with EnergyGauge Loads (Shorter Version)



1. Start Kwik Model
2. Project Info Tab
* Enter Project Name. This is required
* Enter other information, as needed.
* Enter the houses total conditioned floor area under “Cond Floor Plans Area”
3. Libraries Tab
* Specify your default surface types in each table. These will be automatically assigned
to anything you create after the default is set
4. Floor Plan Tab
* Elevations
o Start with the first floor. (return here for other floors)
o Set default floor thicknesses (default = 0.5’) and ceiling height (default = 8”)
* Import Floor Plan - select file.
o Ifyou have a pdf that is too large to import, open windows snipping tool,
take a screen snip, and save it as a png instead.
* Scale Floor Plan.
o Turn on the 2D toggle, and click on the “top” view button at the top right.
o Scale left to right using the red line
o Scale forward to back using the blue line
o Double-check dimensions with yellow ruler arrows.
* Drag and Rotate - Move Floor Plan as needed

* Crop Floor Plan - Crop Floor Plan if necessary
o One set of sliders handles how much the images stretches out on the floor

o The other set offsets the image
* Rotate Front - Adjust front of the building in reference to the floor plan by rotating the
flat cylinder that appears with the mini house on it, or by entering the forward angle. 5. Rooms
Tab
* Place boxes of various shapes to cover all rooms, vaulted ceilings, etc.
* Group boxes into rooms so that each room will have at least one register. Group
ceilings with the room boxes below for taller or slanted rooms.
* Indicate any unconditioned rooms (e.g., garage) using the type of space’ dropdown *
For below grade rooms, create “Earth” boxes that touch wherever the conditioned
space is below grade.
* Click “Check Alignment” to highlight any small gaps, make sure these are intentional. * If
you have any floating rooms, select them and click “touch floor” to extend down the
raised floor automatically.
6. Windows/Doors Tab
* Place all windows, skylights and exterior doors
* For Doors, you can mark one as the main/front door.
<<Repeat steps 1 - 6 for additional stories (floors)>>
7. HVAC Draw Tab
* Place at least one air handler to represent a block/system
* Rotate it and scale its sections as you see fit
* The lighter [X] end is the supply the darker [/] end is the return
8. Roofs Tab
* Place roofs as needed. Drawing a roof is Optional .
* If you don't want to place a roof, turn on the ‘enter main roof slope manually’ toggle
and enter the slope below
* Make sure that if the manual roof slope tab is turned off, that you set one of the roofs
to be the “main” roof.



* Set the type of the main roof, other roofs will have no bearing on the loads
9. Data Tab
* Rooms Table
o Name all rooms
o Double check that all boxes are associated with a named room.
o If more that one air handler was placed, assign rooms to air handlers in
“System/Block” column (this will be automatically selected if a duct is
connected to it from a system)
o Assign a “Room Type” to each room.
o Enter # of occupants in each room
* Walls Table
o Assign wall Types, as needed.
o Double check walls against plans.
o Mark any that won't have heat transfer as “Touching Conditioned” in the last
column
* Ceilings Table
o Assign Ceiling Types, as needed.
o Double check Ceilings against plans. Make sure there are none showing up
that should be touching conditioned space above
* Floors Table
o Assign Floor Types, as needed.
o Double check Floors against plans.
o Make sure there are none showing up that should be touching conditioned
space below.
1. If there is conditioned space below that is not in the drawing, set the
floor touching it to “Touching Conditioned” in the last column.
* Windows Table
o Window names can be changed, if desired.
o Assign window Types, as needed.
o Double check windows against plans.
* Doors Table
o Door names can be changed, if desired.
o Assign Door Types, as needed.
o Double check Doors against plans.
10. Energy Gauge Loads
* Confirm that you want to save your work to this point.
* Save it under the same name or a new name.
* Edit “Climate Location”
o Select State
o Select City that is closest to location of project
o Confirm design conditions with the local jurisdiction having authority.
o Select your desired “Sizing Design”
o Click “Return to M] System Loads and Inputs”
* Edit “Cooling”
o Add each cooling system by clicking the red “+”".
Select “Type”
Select “Subtype”, if needed
Select the block served by this cooling system (top right corner of screen)
Check the box if the cooling system is ductless.
Click “Return to System Loads and Inputs”

o O O O O



* Edit “Heating”

o
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Add each heating system by clicking the red “+”".
Select “Type”

Select “Subtype”, if needed

Select the block served by this heating system (top right corner of screen)
Check box if heating system is ductless.

Click “Return to System Loads and Inputs”

* Edit “Duct”

o}
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Add a duct system by clicking the red “+”.

Specify the heating and cooling system connected to it
Specify supply and return duct R-values

Specify supply and return duct locations

Specify air handler location

Specify duct condition

Specify a leakage type.

o Indicate blower heat added to air stream (usually not needed)

O

Click “Return to System Loads and Inputs”

* Edit “Mechanical Ventilation”
o Add a mechanical ventilation system by clicking the red “+”.
o Specify ventilation air type and complete all info as needed.
o Specify which block is served by this mechanical system.

O

Click “Return to System Loads and Inputs”

* Confirm set points in conditioned space (68 and 75 are standard) *
Confirm Infiltration method (Default is recommended)

* Confirm window peak load option (summer is recommended)

* Confirm Internal Gains (leave checked)

* Click “Calculate ACCA M]8 Loads”

o Innew screen, click on “Reports” tab at top. Review all reports.

* Click “Continue to Manual S Equipment Selection ==>"
* Click “Edit Block 1” under step 2

O
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Review OQutdoor Conditions
Review Room Conditions
Review Manual ] Design Loads
Review heating and cooling targets
Check box accepting responsibility
Click “+ Step 2. AHRI Heating and Cooling Equipment”
1. Select equipment according to Manual S
2. Enter AHRI number (use 0000000 if generic)
3. Enter other equipment information, if known
Click “+ Step 3. AHRI Heating and Cooling Capacities and Efficiencies at AHRI
Test Conditions”
1. Enter information, if known
Click “+ Step 4. HVAC Fan Specifications”
1. Indicate fan type
2. Indicate fan speed for heating and cooling
3. Enter HVAC fan airflow for heating and cooling
4. Enter external static pressure for heating and cooling
Click “+ Step 5. Estimate Airflow Temperatures Entering Equipment”
1. Enter values or click “Show suggestions”
Click “+ Step 6. OEM Specs at Design Conditions”



1. Enter values, if known.

o Click “+ Step 7. Print Manual S Report”
1. Review and revise if needed.
2. Exit by clicking “X Quit”

o Click “Close/Return”

1. Confirm that data entered will be used for equipment previously
entered.
o Repeat this section for other systems, if any.
o Click “<= Close Page/Return to Manual S Overview”
* Click “* Save Work and Return to Kwik Model”
* Click “OK”
11. You will return to the Data Tab
* Go to Rooms Table. Confirm that room loads and room cfms look reasonable. *
Remember to save your progress to lock the loads into your KwikModel project 12. Duct
Draw Mode (HVAC Draw Tab)
* Place at least one register in every room.
* Place at least one return grille for each system.
* Draw ducts.
13. Friction Rate Mode
* Use TEL table to calculate total equivalent lengths.
* Use Friction rate table to calculate friction rate.
14. Data Tab
* Go to Duct table
o If more than one return was drawn, assign supply branches to returns.
o Assign duct types.
o Click “Auto Size Ducts”.

Review everything! Recalculate loads and resize ducts if you make any changes.
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